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1:Overview of RML-1

1-1;Command Set
RML-1 commands are grouped as commands for mode 1, commands for mode 2, and
commands that are common to both mode 1 and mode 2.

Mode 1:Composed of one letter or symbol; based on DXY-GL.

Mode 2:Composed of two letters; based on RD-GL.
Common to mode 1 and mode 2:  Composed of an "I" plus two letters.
For all three, the unit of measurement for the coordinate system is 1/100 mm.
Character codes are composed of 8-bit ASCII codes. valid letter, numerals, and symbols are
0x7f and lower. A code of 0x80 or higher results in an error even if the letter produced when
the eight bit (MSB) is zeroed is a valid command. When the communication parameters are

set for 7-bit sending, the data is converted to 8 bits, with the MSB assumed to be zero.

1-2;Supported RML Commands
Mode 1 D

PQNs=<TZIT I

Mode 2 DF
IN
PA
PD
PR
PU
VS

Common to mode 1 and mode 2

'DW
IMC
INR
IPZ
IRC
vz
IZM
1ZO
1ZZ

1IZE
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2:Command Format

2-1;Description

Commands are made up of letters and some symbols, and parameters are or a combination
of the two. Parameters are made up of numerals, which may be signed. Commands and
parameters are separated by delimiters and terminators.

Also, commands and parameters are eight bits, and have significance as character strings
when the most significant bit is zero. When this is not zero, the character string is neither a
command nor a parameter.

Each of these is described below.

2-2:Format for Mode 1
Format example * D ** 5000 ** [,] ** 5000 ** [terminator]

[Delimiter]
"*" indicates a character whose ASCII code is for the space or lower, or the ;"
character. One or more may be used, without restriction.
"**" indicates either the space or the tab character. One or more may be used,
without restriction.
[.] indicates the "," (comma) character. Only one may be used.

[Command]
The location shown by "D" is the command. It appears as a single letter or,

depending on the model, as "@", "!", ", or "_". If D is preceded by a numeral or by

"+ or ", it is read and discarded with error 2. All other characters at 0x20 or
lower, and ";", are ignored.
When a single letter is recognized, a case-insensitive comparison is performed
against the list of valid commands for the model, and if the character string does not
match it is discarded with error 1. If a match is made, the corresponding command
is executed. Get parameters as required.

[Parameter]
The location shown by "5000" is the parameter. [,] is used as the delimiter for
parameters. Details are similar to parameters for mode 2.

[Terminator]
This is formally "CR + LF".
Unless specially noted otherwise, this can be omitted when followed by the next

command.
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Special conditions are described in section 2-5.

2-3;Format for Mode 2
Format example * P ** A** 5000 ** [,] ** 5000 ** [terminator]

[Delimiter]
"*" indicates a character whose ASCII code is for the space or lower, or the ;"
character. One or more may be used, without restriction.
"**" indicates either the space or the tab character. One or more may be used,
without restriction.
[,] indicates the "," (comma) character. Only one may be used.

[Command]
PA is the command, and is shown by two letters.
Only a space or tab may validly appear between the P and the A. There is no
restriction as to the number of space or tab characters. If a character other than
space or tab is used, it is read and discarded it with error 1. If P is preceded by a
numeral or by "+","-", or ".", it is read and discarded with error 2. All other characters
at 0x20 or lower, and ";", are ignored.
When composed of two letters separated by a delimiter, a case-insensitive
comparison is performed against the list of valid commands for the model, and if the
character string does not match it is discarded with error 1. If a match is made, the
corresponding command is executed. Get parameters as required.

[Parameter]
This is a numeral and "+", "-", or ".". The characters that appear are not RML-1
commands.
The "+" may be omitted. The value "5000" must follow without any intervening extra
characters. If a character other than a numeral or "+", "-", and "." appears, the
character string up to that point is taken to be a single parameter.
A parameter has no E expression. They are composed only of numerals and ".", "+",
and "-". A parameter that is larger or smaller than the expected value results in error
3. Except for portions such as PU/PD that have already been executed, this portion
of the parameter is not executed.

(Valid numerical ranges of parameters:)

int type This indicates a range of -32768 to 32767. A size of two bytes is
ssumed.
long type This indicates a range of -8388608 to 8388607. A size of four

bytes is assumed.
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float type This indicates a range of -8388608.0 to 8388607.0. A size of four
bytes and IEEE format are assumed.
Special conditions are described in section 2-5.
[Terminator]
This is ";". The [terminator] is formally ";".
Unless specially noted otherwise, this can be omitted when followed by the next
command.
It is required if not followed by the next command.

Special conditions are described in section 2-5.

2-4:Format for Commands Common to Mode 1 and Mode 2
Format example *!** p ** zZ ** 200 ** [|] ** 100 ** [terminator]

[Delimiter]
"*" indicates a space or lower, or the ";" character. One or more may be used,
without restriction.
"**" indicates either the space or the tab character. One or more may be used,
without restriction.
[,] indicates the "," (comma) character.Only one may be used.

[Command]
Except for the addition of "!", the system is similar to mode 2.
If the "I" is preceded by a numeral or by "+", "-", or ".", it is read and discarded with
error 2.

All other characters at 0x20 or lower, and ";", are ignored.
When "I" is detected, interpretation of the following letter follows the rules for mode
2 commands, so refer to the description of mode 2 commands for the P and Z
portions.
[Parameter]
This is similar to the parameters for mode 2.
[Terminator]
The [terminator] is formally "CR + LF" for mode 1 and ";" for mode2.
Unless specially noted otherwise, this can be omitted when

followed by the next command.

2-5;Specific Examples of Special Cases Not Described Above
When a parameter contains a special character, and a "+", "-", "." (period), or

numeric string in a parameter string delimited by a command character and a
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delimiter or terminator loses its significance as a numerical value, the

character is treated as a terminator.

(Examples)
PA100,,100; is equivalentto  PA100,;,100;
PA100++100; is equivalentto  PA100;++100;
PA100..100; is equivalentto  PA100.;.100;
PA100,.100.0; is equivalentto  PA100,0.100;.0;
PA 100.0, 100; isequivalentto PA100,0;0,100;
PA - 100, 100; is equivalentto  PA-;100,100;
PA . 100, 100; is equivalentto  PAO0;100,100;
PD, is equivalentto  PD;,
PD$ is equivalentto  PD;$
PD< is equivalentto PD;<
PD"C is equivalentto PD;"C
PD[TAB]0,1; is equivalentto PDO,1;
PD-[CR]0,1; is equivalentto  PD-;0,1;

When getting parameters, only the number of parameters that could be

obtained completely and correctly is executed.

(Specifically, cases resulting in an error are excluded.)

IP-; is executed with zero parameters.
IP 100,-; is executed with one parameter.
IP 100,100,-; is executed with two parameters.

IP 100,100,200,-;
IP 100,100,200,200;
IP 100,100,200,200,300;

is executed with three parameters.

is executed with four parameters.

is executed with four parameters. Only the required
parameters are obtained. The final ",300" is passed to
the next command search.

PD-;

PD 100,-;
Also, if the value of a parameter is out of range for its type (such as int), it is limited

is executed with zero parameters.

is executed with one parameter.

to the type's maximum or minimum value.

In command processing, two letters must be obtained for mode 2 commands and
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common commands. Even when the portion is only one letter and the determination
is made that there is no corresponding command, it is necessary to get one more
letter.

3;Descriptions of Commands

3-1;Mode 1
@ (Input Z1 & Z2 command)
<Format>
@ z1 (, z2) [terminator]

<Parameter type>

z1: long
z2: long

<Parameter range>
z1: Negative Z-axis operating range to O
z2: 0 ~ 8388607
<Description>
This sets point Z1,Z2 in the workpiece coordinate system.
Z1,72 specify a relative value from ZO0 in the workpiece coordinate system.
When Z2 is not specified, the value already in effect is reused.
When no parameter exists, the value set using the operation panel may be
used, although this varies according to the model.
If either Z1 or Z2 (but not both) generates an error, the setting is made for
the value that did not generate an error.
<Errors>
Error3 results if Z1 is higher than zero or if Z2 is less than zero.
Error 3 similarly results when Z1 is outside the work area.
No error results when Z2 is outside the work area.
<Other Matters>
When Z2 is outside the work area, no error is generated and the setting is
made, but actual Z2 operation stop at the topmost location. (This is

because movement is physically impossible.)

D (Draw -- Line-cutting command)
<Format>

D x1, y1, x2, y2,..., Xn, yn [terminator]
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D [terminator]
<Type>

xn: float

yn: float

<Parameter Range>
-8388608.0 ~ 8388607.0
<Description>

This sequentially cuts line segments between coordinates specified from
the present tool location, in the sequence x1,y1, x2,y2,..., xn,yn. The
coordinate values are all absolute coordinates. Thereafter the system is in
the absolute-coordinate mode.

<Errors>
For the parameters, a pair of values, x and y, constitute a single set, and
more than one set may be stated.
When the number of parameters is odd, each pair is sequentially
interpreted from the beginning as x and y and is executed accordingly, and
the final remaining odd value generates error 2. Execution is not

performed.

I (Relative draw -- Relative-coordinate line-cutting command)
<Format>

I dx1, dy1, dx2, dy2,..., dxn, dyn[terminator]

| [terminator]
<Type>

float

<Parameter Range>
-8388608.0 ~ 8388607.0
<Description>

This performs cutting at the Z1 height from the present tool position to the
coordinates specified by the amount of change along the X axis dx1 and
the amount of change along the Y axis dy1l. It next performs cutting at the
Z1 height from the position moved to, to the coordinates specified by the
amounts of change dyl, dy2 for the corresponding X and Y axes. This
sequentially performs cutting up through the final specified coordinates.
This cuts line segments between coordinates.

The coordinate values are all relative coordinates, and the system goes

into the relative-coordinate mode.
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When the machine is at a height other than Z1 when first moving to the
amounts of change dx1, dyl, the spindle is rotated if it is in a rotatable
state, and after rotation stabilizes, movement to the Z1 height is effected at
the speed specified by 'VZ or V. Thereafter movement to the coordinates
specified by dx1, dyl is effected.
In cases where this command appears when the height is already at Z1,
the spindle is rotated if it is in a rotatable state, and after rotation stabilizes,
movement directly to the coordinates specified by dx1, dyl is effected.
<Errors>
For the parameters, a pair of values, x and y, constitute a single set, and
more than one set may be stated.
When the number of parameters is odd, each pair is sequentially
interpreted from the beginning as x and y and is executed accordingly, and
the final remaining odd value generates error 2.Execution is not

performed.

M (Move -- Linear-movement command)
<Format>
M x1, y1, X2, y2,..., Xn, yn [terminator]
M [terminator]

<Type>
float
<Parameter Range>
-8388608.0 ~ 8388607.0

<Description>
This sequentially moves linearly at the Z2 height between coordinates
specified from the present tool location, in the sequence x1,y1, x2,y2,...,
Xn,yn.
The coordinate values are all absolute coordinates, and the system goes
into the absolute-coordinate mode.

<Errors>
For the parameters, a pair of values, x and y, constitute a single set, and
more than one set may be stated.
When the number of parameters is odd, each pair is sequentially
interpreted from the beginning as x and y and is executed accordingly, and
the final remaining odd value generates error 2. Execution is not

performed.

-10 -
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R (Relative move -- Relative-coordinate linear-movement command)
<Format>

R dx1, dyl, dx2, dy2,..., dxn, dyn [terminator]

R [terminator]
<Type>

float

<Parameter Range>
-8388608.0 ~ 8388607.0

<Description>
This performs movement at the Z2 height from the present tool position to
the coordinates specified by the amount of change along the X axis dx1
and the amount of change along the Y axis dyl.
It next performs movement at the Z2 height from the position moved to, to
the coordinates specified by the amounts of change dy1, dy2 for the
corresponding X and Y axes. This sequentially performs movement up
through the final specified coordinates.
It performs linear movement between the coordinates.
Movement is generally at the highest speed of the particular model.
The coordinate values are all relative coordinates, and the system goes
into the relative-coordinate mode.
When the machine is at a height other than Z2 when first moving to the
amounts of change dx1, dyl, the spindle is rotated if it is in a rotatable
state, and after rotation stabilizes, movement to the Z2 height is effected at
the speed specified by 'VZ or V.
Thereafter movement to the coordinates specified by dx1, dy1 is effected.
In cases where this command appears when the height is already at Z2,
the spindle is rotated if it is in a rotatable state, and after rotation stabilizes,
movement directly to the coordinates specified by dx1, dy1l is effected.
<Errors>
For the parameters, a pair of values, x and y, constitute a single set, and
more than one set may be stated.
When the number of parameters is odd, each pair is sequentially
interpreted from the beginning as x and y and is executed accordingly, and

the final remaining odd value generates error 2. Execution is not

-11 -
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performed.

A (Call mode 2 -- Command for calling a mode 2 command)

<Format>

A [mode 2 command] [parameter]...[parameter] [terminator(;)]

<Parameter Range>

This depends on the mode 2 command set.

<Description>

<Errors>

This calls a mode 2 command from mode 1.

For parameters, refer to the description for the called mode 2 command.
When only " is given, this instruction set does not end until a mode 2
command is executed or until a numeral, sign, or other such data that

results in a mode 2 error is encountered.

This command itself does not generate any errors.

Generation of an error by the mode 2 command is possible.

Also, if the called mode 2 command does not exist, then in principle error 2
for mode 2 is generated at that time.

H (Home -- Origin-movement command)

<Format>

H [terminator]

<Description>

<Errors>

This moves the tool to the uppermost position, then moves to the
workpiece-coordinate origin point on the XY plane. It then stops the
spindle motor.
If the workpiece-coordinate origin point is outside the cutting range, then
this moves, for example, to the clip location.

-> Command errors are cleared.

-> After the operation, the settings for tool-up, absolute-

coordinate mode, and coordinate values are reset.

The present position of the tool is the same as the position in the

workpiece coordinate system.

No error is generated.

<Other Matters>

-12 -
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There is no change before and after command execution in the XY origin

point or in the value of Z0 set using the control panel.

F (Velocity XY axis -- X- and Y-direction speed setting command)

<Format>

<Type>

F tool-speed [terminator]

F [terminator]

Basically int

float for noninteger values such as F 0.5

<Parameter Range>

-32768 ~ 32767 [mm/sec]

<Description>

<Errors>

F without a parameter is set to the default speed.

When a parameter is present and is a settable speed, the speed is set to
the value of the parameter.

When the value of the parameter is the model's capacity or higher, the
model's Maximum speed is used.

When the value of the parameter is the model's capacity or lower, the
model's minimum speed is used.

In operation, achieving the actual given parameter value cannot be
guaranteed.

Depending on the length of the line segment, operation may be slower
than the value specified by the parameter because of an inability to
accelerate fully.

Also, even when full acceleration is possible, the specified speed may not

necessarily be accurately reached; precision may be low.

Examples for some models:

F 0 may be 0.5 mm/sec.

F 0.1 to F 1.0 may be in increments of 0.1 mm/sec.

Values of F 1.0 or higher may be in increments of 1 mm/sec.

The default value may be, for example, 2 mm/sec.

No error is generated.

<Other Matters>

-13-
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Similar to VS.

V (Velocity Z axis -- Tool up/down speed setting command)
<Format>

V tool-up/down speed [terminator]

V [terminator]
<Type>

Basically int

float for noninteger values such as V 0.5

<Parameter Range>
-32768 ~ 32767 [mm/sec]
<Description>

This sets the speed relationship when the tool moves along the Z axis or
when movement is performed using the three-axis simultaneous-
movement command.
V without a parameter is set to the default speed.
When a parameter is present and is a settable speed, the speed is set to
the value of the parameter.
When the parameter is not a settable value, the maximum or minimum
settable value is set automatically.

<Errors>
An out-of-range parameter results in error 3.
When the parameter is within range, no error occurs even if its value

cannot be set on the particular model.

W (dwell -- Dwell specification command)
<Format>
W dwell-time [terminator]
W [terminator]
<Type>
int
<Parameter Range>
0 to 32,767 msec
<Description>
When a parameter is given, if it is a settable value, then dwell (waiting) for

the time set by the value is performed when the cutting direction changes.

14 -
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When W is used without a parameter, the default value is applied (O
msec).

There is no wait time when the direction of cutting changes.

When a two-dimensional command such as PD or PU is used, the dwell
operation is performed just before the PD tool-down operation or just
before moving the XY plane period parameters.

It is also performed just before changing from tool-down to tool-up with
PU.

However, it is not performed when a PU parameter manipulates the XY
plane.

In the case of a PU or PD command without parameters, it is performed
just before the tool-up or tool-down operation.
In the case of a three-dimensional movement command such as !ZZ, it is

performed just before the operation of that command is carried out.

Operations other than the command's are unaffected.
<Errors>

A value less than O or over 32767 results in error 3.
<Other Matters>

Z (XYZ move -- Three-axis simultaneous feed command)
<Format>
Z x1,y1,z1,... [terminator]

<Type>

float
<Parameter Range>
-8388608.0 ~ 8388607.0

<Description>
This moves simultaneously along the three axes from the present
coordinates to the specified coordinate values.
The speed is as set by the V or 'VZ command.
When no parameter is present, no operation is performed.
Additionally, the parameters are interpreted as absolute coordinates when
set to absolute coordinates prior to this command and are interpreted as

relative values when set to relative coordinates prior to this command.

-15-
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<Errors>
For the parameters, three values -- X, y, and z -- make up one set, and
more than one set may be stated.
When the number of parameters is not a multiple of three, the parameters
are interpreted and executed in sequence from the start as x, y, and z, and
the final one or final two results in error 2. The final set is not executed.
<Other Matters>
Common with 1ZZ.

<For Reference>
Vv, \WZ,12Z

3-2:Mode 2
DF (Default — Default-setting command)
<Format>
DF [terminator]
<Description>
This sets some present settings to their standard values.

1. PA This is set to absolute coordinates.
2. VS Speed is set to the default value.
The actual value is model-dependent.
3. vz Speed is set to the default value.
The actual value is model-dependent.
4. IDW Dwell time is set to 0.
5. IMC Rotation is permitted.
6. IPZ The value is initialized. The actual value varies

according to the model.
<Errors>

No error is generated.

IN (Initialize -- Initialize-setting command)
<Format>

IN [terminator]

<Description>
This performs the same operations as the standard settings made by the

DF command, as well as making the following settings.

-16 -
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<Errors>

1. Move the tool to the tool-up position.

2. PU.

3. Clear errors.

4. Stop the spindle motor.

5. Reset the coordinate values. The present position of the tool is the

same as the position in the workpiece coordinate system.

No errors.

<Other Matters>

There is no change before and after command execution in the XY origin

point or in the value of Z0 set using the control panel.

PA (Plot Absolute -- Absolute plot command)

<Format>

<Type>

PA X1, y1, (, X2, y2,....) [terminator]

PA [terminator]

x: float

y. float

<Parameter Range>

x: -8388608.0 to 8388607.0
y: -8388608.0 to 8388607.0

<Description>

<Errors>

A PA command without parameters effects a change to the absolute-
coordinate mode.

When parameters are present, the command effects the absolute-
coordinate mode and performs operation for the coordinate values
specified by the parameters, without change the present state of the tool

(up or down).

For the parameters, a pair of values, x and y, constitute a single set, and
more than one set may be stated.

When the number of parameters is odd, each pair is sequentially
interpreted from the beginning as x and y and is executed accordingly, and
the final remaining odd value generates error 2. Execution is not

performed.

-17 -
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<Other Matters>

PU/PD (Pen Up/Down -- Tool up/down command)

<Format>

<Type>

PU x1, v1, (, X2, y2,....) [terminator]
PU [terminator]
PD x1, v1, (, X2, y2,....) [terminator]

PD [terminator]

x: float

y: float

<Parameter Range>

x: -8388608.0 to 8388607.0
y: -8388608.0 to 8388607.0

<Description>

PU or PD without parameters performs only a tool-up or tool-down
operation.

When parameters are present, the command performs the tool-up or
tool-down operation, then operates to the coordinate value specified by
the parameters.

The parameters used for operation are absolute coordinates when a PA
command has previously been given or relative coordinates when a PR

command has previously been given.

The up or down position uses the height specified using the control panel
or the 'PZ or @ command.
The tool-up location is the Z2 location.

The tool-down location is the Z1 location.

When Z2 is outside the cutting range, the tool rises to the maximum height
at which the device can operate.

If X and Y movement is necessary thereafter, the movement is performed
at the maximum height.

If a PD command appears thereafter, there is no pause when moving from
outside to inside the clipping area, even if such a setting has been made.

Operation is performed without change.

-18 -
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<Errors>

Because Z1 cannot be set outside the device's cutting range, movement

to the set value is performed.

The operating speed for the PD command is set using the VS or F
command.

However, the speed specified by the VS or F command may not
necessarily be reached. Depending on the length of the line segment for
the operation, a slower speed than specified may be set automatically.
The specified speed is reached when the line segment is long enough to

allow sufficient acceleration.

PU operates at a particular specified speed, regardless of the VS
command.

This ordinarily the model's highest speed, but it may be set at a lower
value in some cases.

The specified speed is of course reached when the line segment is of the
required length for acceleration, but in cases where sufficient acceleration

is not possible, a slower speed is automatically used.

For the parameters, a pair of values, x and y, constitute a single set, and
more than one set may be stated.

When the number of parameters is odd, each pair is sequentially
interpreted from the beginning as x and y and is executed accordingly, and
the final remaining odd value generates error 2. Execution is not

performed.

<Other Matters>

Z2 can be set outside the cutting range, and its value is retained.
If Z0 is lowered so that Z2 comes within the effective range, its value is

used.

PR (Plot Relative -- Relative plot command)

<Format>

<Type>

PR x1, v1, (, X2, y2,....) [terminator]

PR [terminator]

-19-
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x: float

y: float

<Parameter range>

x: -8388608.0 to 8388607.0
y: -8388608.0 to 8388607.0

<Description>

<Errors>

A PR command without parameters effects a change to the relative-
coordinate mode.

When parameters are present, the command effects the relative-
coordinate mode and performs operation for the coordinate values
specified by the parameters, without change the present state of the tool

(up or down).

For the parameters, a pair of values, x and y, constitute a single set, and
more than one set may be stated.

When the number of parameters is odd, each pair is sequentially
interpreted from the beginning as x and y and is executed accordingly, and
the final remaining odd value generates error 2. Execution is not

performed.

<Other Matters>

VS (velocity select -- Tool-speed setting command)

<Format>

<Type>

VS tool-speed [terminator]

VS [terminator]

Basically int

float for noninteger values such as vs 0.5

<Parameter Range>

-32768 to 32767 [mm/sec]

<Description>

VS without a parameter is set to the default speed.

When a parameter is present and is a settable speed, the speed is set to
the value of the parameter.

When the value of the parameter is the model's capacity or higher, the

model's maximum speed is used.

-20 -
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When the value of the parameter is the model's capacity or lower, the

model's minimum speed is used.

The given parameter value is not guaranteed to be reached in actual
operation.

Depending on the length of the line segment, operation may be slower
than the value specified by the parameter because of an inability to
accelerate fully.

Also, even when acceleration is possible, the specified speed may not

necessarily be accurately reached; accuracy may be low.

Examples for some models:

VS 0 may be 0.5 mm/sec.

VS 0.1 to VS 1.0 may be in increments of 0.1 mm/sec.

Values of VS 1.0 or higher may be in increments of 1 mm/sec.

The default value may be, for example, 2 mm/sec.

<Errors>
No error is generated.

<Other Matters>

3-3;Commands Common to Mode 1 and Mode 2

IDW (Dwell -- Command to specify dwell)

<Format>
IDW dwell-time [terminator]
IDW [terminator]

<Type>
int

<Parameter Range>
0 ~ 32767msec

<Description>
When a parameter is given, if it is a settable value, then dwell (waiting) for
the time set by the value is performed when the cutting direction changes.

When IDW is used without a parameter, the default value is applied (0

-21 -
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msec).
There is no wait time when the cutting direction changes.
When a two-dimensional command such as PD or PU is used, the dwell
operation is performed just before the PD tool-down operation or just
before moving the XY plane period parameters.
It is also performed just before changing from tool-down to tool-up with
PU.
However, it is not performed when a PU parameter manipulates the XY
plane.
In the case of a PU or PD command without parameters, it is performed
just before the tool-up or tool-down operation.
In the case of a three-dimensional movement command such as !ZZ, it is
performed just before the operation of that command is carried out.
Operations other than the command's are unaffected.

<Errors>

A value less than 0 or greater than 32767 results in error 3.

IMC (Motor Control -- Motor control command)
<Format>
IMC n [terminator]
IMC [terminator]
<Type>
n: int
<Parameter range>
n -32768 through 32767
<Description>
When parameter n is other than 0 or when the parameter is omitted, the
spindle motor is set to a rotatable state.
What actually rotates is
Thereafter, when the tool is moved by a command, the spindle motor is

made to rotate from a stopped state, and then the movement is performed.

When n is 0, rotation thereafter is prohibited.

Also, rotation is stopped immediately after the motor stops.

This command is effective in performing rotation or stoppage after waiting
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until the motor actually stops.

<Errors>
No error is generated.
<Other Matters>
IMC 0 is used in the scribing mode.
When in this state, all operations that rotate the spindle are prohibited.
To cancel this state,
Switch off the power.
Send IMC 1.
Send IN.
Send DF.

The foregoing are the only methods available.

INR (Not Ready -- Preparation-incomplete command)
<Format>

INR [terminator]
<Description>

This effects a paused state.

No parameter is required.

<Errors>

<Other Matters>
This can only be canceled using the control panel.
Depending on the specifications of the model, movement to some specific

location may be performed.

IPZ (Set Z1 & Z2 command)
<Format>
IPZ z1 (, z2) [terminator]

<Type>

z1: long
z2: long

<Parameter Range>
z1: Negative Z-axis operating range to 0
z2: 0 ~ 8388607
<Description>
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This sets the Z1 and Z2 points in the workpiece coordinate system as
relative values from the Z0 coordinate.
If an error occurs with either Z1 or Z2, the setting is made for the one for
which no error resulted.
No setting is made for the one which generated an error.
Z2 may be set outside the work area, but in actual operation it is at the
topmost location in the work area. (Rising beyond that is physically
impossible.)
When no parameters are present, the default values are used.
<Errors>
Error3 results if Z1 is higher than zero or if Z2 is less than zero.
Error 3 also results when Z1 is outside the work area.
No error results when Z2 is outside the work area.
<Other Matters>

Same as the @ command.

IRC (Revolution Control command)
<Format>
IRC n [terminator]
IRC [terminator]
<Type>
n: long
<Parameter range>
n: 0 to 8388607
<Default Values>
None in particular.
Note that although it may be possible to save the spindle rotating speed
depending on the model, the speed value may not be directly related to

the 'RC command.

Also, is the model is provided with hardware control such as a volume

control, the value may be determined by the position of the volume control.

Models that are not capable of saving the spindle speed use the minimum

speed for the model.
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<Description>
This sets the rotating speed of the spindle motor.
Operation varies according to the value of the parameter.
Note that models that are not equipped with both are not provided with a

method for specifying direct rpm.

When at 0 to 99

The setting range for spindle speed is divided into 16 stages from 0 to 15.
These are not absolute values.

A value of 0 is the lowest spindle speed, and 15 is the maximum speed.
Values higher than 15 are clipped to 15.

When at 100 to 8388607

Models that can specify the spindle speed as a direct rpm value specify
the value directly.

However, the actual effective number of digits is model-dependent.

For example, a value of 3124 may produce such differing results as 3,000
rpm, 3,100 rpm, 3,120 rpm, or 3,124 rpm, depending on the model.

Digits other than effective digits are discarded.

Also, when a spindle speed exceeding the model's capacity is specified,
the model's maximum speed is used. Similarly, when a spindle speed
below the model's capacity is specified, the model's minimum speed is
used.

On models not capable of specifying direct rpm, the value is clipped at 15

and the maximum spindle speed is used.

The setting is enabled after operation of the X, Y, and Z motors stops.

When there is no parameter, no execution is performed. The command is

ignored.

Depending on the model, it may not be possible to manipulate the spindle
rotating speed using commands. In such cases, the command, including

the parameter, is ignored.
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<Errors>
A negative parameter (less than 0) results in error 3.

Parameters exceeding 8388607 also result in error 3 and no execution.

IVZ (Velocity select Z axis -- Z-axis feed rate setting command)
<Format>
IVZ s [terminator]
IV [terminator]
<Type>
Basically int
A value that is a decimal fraction, such as !VZ 0.5, must be type float in
order to be achieved.
<Parameter range>
-32768 to 32767 [mm/sec]
<Description>
This sets the speed relationship when the tool moves along the Z axis or
when movement is performed using the three-axis simultaneous-

movement command.

IVZ without a parameter is set to the default speed.

When a parameter is present and is a settable speed, the speed is set to
the value of the parameter.

When not a settable value, the maximum or minimum settable value is set

automatically.

On some models, 'VZ 0 may be, for example, 0.5 mm/sec.

The default value may be, for example, 2 mm/sec.

<Errors>

An out-of-range parameter results in error 3.

When the parameter is within range, no error occurs even if its value
cannot be set on the particular model.
<Other Matters>
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IZM Z-axis Move -- Z-axis movement command
<Format>
I1ZM z [terminator]
IZM [terminator]
<Type>
float
<Parameter range>
Values within the Z-axis movement range.
Because this value is an integer, when a float value is input the decimal-
fraction portion is ignored, and the resulting value must be within the Z-
axis movement range.
<Description>
Coordinate values are specified as machine coordinates.
Movement to the Z-axis coordinate value specified by the z parameter is
performed.
The X and Y axes do not operate at that time.

If a PA command was executed before this command, the Z parameter is
interpreted as an absolute coordinate, and the specified value from the
device's reference coordinate is taken to be the Z-axis origin point,
regardless of where the present Z-axis origin point (Z0) may be.
Conversely, if a PR command was executed before this command, the
parameter is interpreted as a relative coordinate, and the specified value
referenced from the present Z-axis coordinate is made the Z-axis origin.
When no command has been received, the parameter is interpreted as an
absolute coordinate.

Itis also interpreted as an absolute coordinate after an IN or DF command.

When no parameter is present, no execution is performed.

<Errors>
A value for the z parameter that is outside the Z-axis movement range
results in error 3.

<Other Matters>
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1ZO (Set Z0 -- Z0 setting command)

<Format>
1ZO z [terminator]
1ZO [terminator]

<Type>
float

<Parameter range>
Values within the Z-axis movement range.
Because this value is an integer, when a float value is input the decimal-
fraction portion is ignored, and the resulting value must be within the Z-
axis movement range.

<Description>
Coordinate values are specified as machine coordinates.
If a PA command was executed before this command, the z parameter is
interpreted as an absolute coordinate, and the specified value from the
device's reference coordinate is taken to be the Z-axis origin point,
regardless of where the present Z-axis origin point (Z0) may be.
Conversely, if a PR command was executed before this command, the
parameter is interpreted as a relative coordinate, and the specified value
referenced from the present Z-axis coordinate is made the Z-axis origin.
When no command has been received, the parameter is interpreted as an
absolute coordinate.

Itis also interpreted as an absolute coordinate after an IN or DF command.

When no parameter is present, the default value is used.

The default is model-dependent.

<Errors>
A value for the z parameter that is outside the Z-axis movement range
results in error 3.
Other Matters

IZE (Extension axis move -- Three-dimensional-cutting extension-axis movement
command)
<Format>
IZE(Xx1)(Yy1)(Zz1)(Aal)(:(Xx2)(Yy2)(Zz2)(Aa2)...) [terminator]
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<Type>
float
<Parameter range>
Axis name: A through Z or a through z
Value: -8388608.0 through 8388607.0
<Description>
This moves (or rotates) the specified axis from the present coordinate or
angle to the specified coordinate or angle.
Each parameter that follows !ZE is given in a format composed of a letter
of the alphabet indicating the name of an axis and a numerical value

indicating the movement-destination coordinate.

For example, the command to move to the location when the X axis is 100,
the Z axis is 200, and the A axis is 90 is |ZE X100Z200A90[terminator].
Also, axis names are not case-distinctive. This means that "A" and "a"

mean the same thing.

The parameter for a rotation axis is specified as an angle.

The minimum resolution angle and the direction of rotation vary according
to the model used.

IZE A30.5 [terminator] -- This rotates the A axis by 30.5 degrees.

The axis parameters may be specified in any order.

IZE Z300X100Y200 [terminator] is equivalent to !ZE X100Y200Z300
[terminator].

The movement speed is as set by the V or 'VZ command. Also, when
rotation of the rotation axis is involved, the rotation speed varies according
to the model used.

When there is no parameter, no execution is performed.

Additionally, the parameters are interpreted as absolute coordinates when
set to absolute coordinates prior to this command and are interpreted as
relative values when set to relative coordinates prior to this command.
When scaling is applied, the x and y values are scaled. Other axes are not

affected by scaling. The value is used without change.

Multiple settings may be made by separating parameters using the ":"
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separator.

Axes for which nothing is specified keep their present location and do not
operate.

Example: When the present locations (for X, Y, Z, and A) are respectively
at the (100, 200, 300, 45) coordinates and !ZE X123Y456:X987Z-200
[terminator] is given, the X and Y axes first move simultaneously to (123,
456). At this time the other axes for

which nothing was specified (the Z and A axes) remain stopped. Next, the
X and Z axes move simultaneously to the coordinates (987, -200).
Similarly, the axes for which nothing was specified (the Y and A axes)

remain stopped.

Giving only separators without stating any parameters at all does not
generate an error, but no operation is performed.

Example: |ZE:: [terminator]

Specifying an axis that the model used does not have causes the
specification for that axis to be ignored, but the other axes operate.

When "IZE X100Y200Z300 [terminator]" is specified for a model that has
no Y axis, the parameter for Y-axis movement is ignored, but the other

axes (X and Z) move to their respectively specified locations.

Movement operation occurs only after interpretation of the separator or
terminator.

When !ZE X100Y200:Z300A400; is given, the X and Y axes respectively
move to (100, 200) when the first separator is interpreted.

Next, the Z and A axis respectively move to (300, 400) when the final
terminator is interpreted.

If an error occurs in a parameter statement, operation including the
parameter where the error occurred and everything thereafter up to the
terminator is skipped as invalid data.

When !ZE X100Y200:Z300A:X0Y0ZO0 [terminator] is given, firstly, the X
and Y axes respectively move to (100, 200) at the first separator.

Then, because the next set of parameters contains an "A" parameter with
no specified numerical value, error 3 occurs at this point, and everything

up to the final terminator is skipped.
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Consequently, the only operation of the foregoing command is to move the
X and Y axes respectively to (100, 200).

<Errors>
Parameters that attempt simultaneous movement of axes that cannot
operate at the same time (such as the Y and A axes on an MDX-650
equipped with a rotating axis) result in error 3.
IZE X100Y200Z300A90 [terminator] -- This attempts to operate the Y and

A axes simultaneously, resulting in an error.

Specifying the same axis two or more times without delimiting the
statements by a separator results in error 2.
IZE X100Y200X300 [terminator] -- This specifies an X-axis parameter

twice, resulting in an error.

Giving only the name of an axis without specifying a numerical value
results in error 3.

Specifying only a numerical value without stating the name of an axis also
results in error 3.

IZE X100Y [terminator] -- No movement-destination coordinate is
specified for the Y axis, resulting in an error.

IZE 100 [terminator] -- No axis name is specified, resulting in an error.

One or more spaces occurring between the command "!ZE" and a
parameter such as "X100" or between a parameter such as "X" and a
numerical value such as "100" does not result in an error, but a numerical
value that is not an unseparated string results in error 3.

IZE X 100 Y 200 : Z 300 A 90 [terminator] -- Normal operation

IZE X 100 Y 2 00 [terminator] -- The final "00" is interpreted as having a

missing axis name, resulting in an error.

Attempting to specify an axis using a character other than A through Z (or
a through z) results in error 3.
<Other Matters>
The names of axes vary according to the model used.
The final terminator for this command may not be omitted.

On a model equipped with a rotation axis, the rotation speed of the axis
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depends on the model used.

1ZZ (Z three-axis simultaneous-feed command)
<Format>
177 x1,y1,z1,... [terminator]

<Parameter Range>
-8388608 ~ 8388607
<Description>

This moves simultaneously along the three axes from the present
coordinates to the specified coordinate values.
The speed is as set by the V or 'VZ command.
When no parameter is present, no operation is performed.
Additionally, the parameters are interpreted as absolute coordinates when
set to absolute coordinates prior to this command and are interpreted as
relative values when set to relative coordinates prior to this command.
<Errors>
For the parameters, three values -- X, y, and z -- make up one set, and
more than one set may be stated.
When the number of parameters is not a multiple of three, the parameters
are interpreted and executed in sequence from the start as x, y, and z, and
the final one or final two results in error 2. The final set is not executed.
<Other Matters>
Similar to the Z command.
The description is also similar to that for the Z command.
<For Reference>
V, WVZ

4:Device Control Commands

4-1;Format of Device Control Commands

[ESC]. K
[ESC].MP1;P2;P3;P4;P5; P6:

[ESC] corresponds to hexadecimal 1B.
Although these are used to illustrate the format, the ESC.M and ESC.T commands

are not supported in RML-1.

<Commands>
This must be in the sequence of "[ESC] . letter/certain symbol”.

-32-



B Roland

RML-1 PROGRAMING GUIDELINE

This sequence starts when an [ESC] is received from the computer.

When a sequence is determined not to correspond to the foregoing, it is

interpreted as a mode 1, mode 2, or common command, and the order of

characters appearing in the sequence is passed unchanged.

Error determination is performed by the side that is passed the sequence.

If the character following [ESC] . is unsupported, then communication

error 11 is generated and the sequence ends.

The [ESC] . is discarded and the character appearing next is passed

unchanged to the data buffer.

Error determination is performed by the side that is passed the sequence.
<Parameters>

These are numerals only, and the delimiter for parameters is ";".

Whenever a ";" appears, the value is interpreted and the setting is made.

This final parameter is ":", and indicates the end of the sequence.

Parameter values may be omitted; when omitted, the setting is made

using the default value.

[Examples]
ESC.M:
In the foregoing case, all are assumed to be omitted, and defaults are

used for all.

ESC.M;;;13:

In the foregoing case, the first through third parameters are interpreted as
being omitted, the fourth parameter is interpreted to be 13, and
parameters thereafter are interpreted as being omitted. Default values are
used for the omitted parameters.

The numerical range is from 0 to 65535.

An out-of-range value results in communication error 13 and is not used;
the default value is used instead. The sequence is continued and the next
parameter is awaited.

If a character other than a numeral, ";", ":", or [ESC] appears during the
course of a parameter, the parameter is interpreted as being omitted, its
value is discarded, and the default value is used instead.

Additionally, error 12 is generated and the sequence ends.

The problematic character that is other than a numeral, ";", or ":" is passed
to the data buffer.

[Examples]
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ESC.T10XYZ;100;...
In the foregoing case, ESC.T is interpreted up to 10, the following X is

determined to be uninterpretable, and the result of up to ESC.T10 is
interpreted on the device-control side and discarded.

XYZ and after is stored in the data buffer.

Also, the error-12 parameter produces an improper setting, the ESC.T is
interpreted as having an omitted parameter, the default setting is made,

and the sequence ends.
ESC.T1000;20XYZ;...
In the foregoing case, the first parameter is set as specified, default

settings are made for the second and later parameters, and the sequence
ends.
An error-12 setting is made, and XYZ and after are passed to the data

buffer.
ESC.T1000;2000;XYZ;...
The 1000, 2000 parameters are processed correctly.

The appearance of X results in error 12 and the sequence ends.

XYZ and after are passed to the data buffer.
ESC.T1000;2000;ESC
The 1000, 2000 parameters are processed correctly.

The appearance of ESC results in error 12 and the sequence ends.

This is interpreted as a new device-control sequence occurring again.
When [ESC] is received.

In the same way as above, processing is performed and error 12 is
generated.

What differs from the foregoing is that this is interpreted as a new device-
control sequence occurring again without passing [ESC] to the data buffer.
When there is an excessively large number of parameters.)

Error 14 is generated and the excess parameters are ignored.
Interpretation as a sequence continues without change.

However, the superfluous parameters are ignored and are not stored in
the data buffer.

Error List

0 No error.

10 Multiple output requests.

~34-



B Roland

RML-1 PROGRAMING GUIDELINE

11

12

13

14

15

16

17

18

Multiple Errors

Output for the earliest request is executed, and the superfluous
output request or requests are ignored.

Ignored commands are not stored in the data buffer.

Device control command error
Everything up through [ESC] . is discarded, and the command is
stored in the data buffer without interpreting the character

thereafter that resulted in the error.

Incorrect parameter.
The parameter that generated the error is set again using its

default value.

Parameter overflow.
The parameter that generated the error is set again using its

default value.

Too many parameters.

A framing error, parity error, or overrun error occurred.

The receive buffer experienced overflow.
This occurs in cases such as when the handshake settings do

not match.

Not used.
On some models this is assigned to baud-rate error, but this error
cannot be detected unless there is hardware support.

Normally this is error 15.

Other unspecifiable communication error.
Normally this is not generated and is not used.
This is used in cases of special need to provide notification of

some communication error.
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The errors described here are all communication-related, and are
unrelated to errors that may occur in the interpretation of RML commands.
Specifically, this applies only to 10 through 18, and has no connection with
errors whose numbers are less than 10.

When more than one error occurs, the first error number is the one that is
saved.

Those coming after are ignored.

Parallel
The extent of interpretation is model-dependent, but cases of operation
similar that when using the serial connection are also possible.
Note that those commands which are physically inoperable, such as those

that perform response, are naturally not supported.

Replot

Nothing is performed.

4-2;Descriptions of Device Control Commands
ESCK Command
ESC.K Command-quit command

<Format>
[ESC].K
[ESC] is actually one character. It corresponds to 1B hexadecimal.

<Description>
This ends operation of the command now being executed and discards
without executing it all buffered data until the next ESC.K after the
command is processed.

<Errors>

None.

Other Device Control Commands
Other device control commands are basically unsupported.

5:Appendix
5-1,Three-dimensional Movement
Clipping Behavior During Three-dimensional Operation
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Cases of clipping can be classified as follows. (Commands sent at this
time are all taken to be three-dimensional movement

commands.)

A The cutting range can be represented by a regular parallepiped, and when
operating within this regular parallepiped there is no problem with only
simple operation.

=> Because clipping is not performed, there are no effects.

B The cutting range is a regular parallepiped and movement extends from a
particular side surface and enters the same side surface.
There are two types of operation.

1. Movement extends outside the side and again enters the clipping area at
the same side with change in only the Z-axis height, with no movement of
the X or Y axes.
=> Move only the Z axis to recover at the location of movement
outside.

2. Movement extends outside the side and again enters the clipping area at
the same side with movement of the X and Y axes.
=> Raise the tool all the way up once, move the X and Y axes to the

recovery location, then lower the Z axis to the recovery height.

C The cutting range is a regular parallepiped and movement extends from a
particular side surface and enters a different side surface.
=> Raise all the way up once, move only the X and Y axes, then

lower only the Z axis.

D The cutting range is a regular parallepiped and movement extends from a
particular side surface and enters from the top surface and not from a side
surface.
=> Raise all the way up once, move only the X and Y axes, then

lower only the Z axis.

E The cutting range is a regular parallepiped and movement extends from a
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particular side surface and enters from the bottom surface and not from a
side surface.

=> When the protrusion is only from the bottom surface, move only
the X and Y axes without moving the Z axis.

This means that the side is entered first in order to enter the bottom
surface, and so B applies.

Because Z extends from the bottom surface, lower all the way.

While in this state, move only the X and Y axes at the speed set by the 1ZZ
command until protrusion from the side is effected again.

If there is extension from a side, no operation is performed.

If Z extends from the bottom surface, move all axes (X, Y, and 2Z).

If pause outside the cutting area is enabled, effect a pause at that point.

The cutting range is a regular parallepiped and movement extends from a
particular top surface and enters from the same top surface.
Perform direct movement.

Because the Z axis is all the way up, no operation is performed.

The cutting range is a regular parallepiped and movement extends from a
particular top surface and enters a side surface.

With the Z axis in a completely raised state, move only the X and Y axes to
the location of entry into the side.

Next, lower only the Z axis.

The cutting range is a regular parallepiped and movement extends from a
particular top surface and enters the bottom surface on the opposite side.

Combination of G and E.

The cutting range is a regular parallepiped and movement extends from a
particular bottom surface and enters a side surface.

=> When the protrusion is only from the bottom surface, move only
the X and Y axes without moving the Z axis.

While in this state, move only the X and Y axes at the speed set by the 1ZZ
command.

If there is extension from a side, no operation is performed.

Either of the following is applied, depending on whether the enter is from
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the same side.

The cutting range is a regular parallepiped and movement extends from a
particular side surface and enters the same side surface.

The cutting range is a regular parallepiped and movement extends from a

particular side surface and enters a different side surface.

The cutting range is a regular parallepiped and movement extends from a
particular bottom surface and enters the same bottom surface.

=> When the protrusion is only from the bottom surface, move only
the X and Y axes without moving the Z axis.

While in this state, move only the X and Y axes at the speed set by the 12Z
command.

If Z extends from the bottom surface, move all axes (X, Y, and Z).

If pause outside the cutting area is enabled, effect a pause at that point.

The cutting range is a regular parallepiped and movement extends from a
particular bottom surface and enters the top surface on the opposite side.
When the protrusion is only from the bottom surface, move only the X and
Y axes without moving the Z axis.

While in this state, move only the X and Y axes at the speed set by the 1ZZ
command.

If there is extension from a side, no operation is performed.

First raise all the way up, move the X and Y axes to the location of entry,

then lower only the Z axis.

- Movement outside with a three-dimensional movement [J
command and entry with PU/PD

Z1 and Z2 are assumed to be set inside the regular parallepiped.

When Z2 is on the top of the regular parallepiped, movement to Z2 cannot
be performed.

This is all the way at the top. Refer to the sections for the PU and PD
commands.

The cutting range is a regular parallepiped and movement extends from a

particular side surface and enters the same side surface.
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=> The case for "B The cutting range is a regular parallepiped and
movement extends from a particular side surface and enters the same

side surface" applies.

M The cutting range is a regular parallepiped and movement extends from a
particular side surface and enters a different side surface.
=> The case for "C The cutting range is a regular parallepiped and
movement extends from a particular side surface and enters a different

side surface" applies.

N The cutting range is a regular parallepiped and movement extends from a
particular bottom surface, and a PU or PD operation is performed while the
X and Y coordinates are inside the regular parallepiped.
=> Because the X and Y axes are already at the coordinates, move

only the Z axis to Z1 and Z2, then move the X and Y axes.

@] The cutting range is a regular parallepiped and movement extends from a
particular bottom surface, and a PU or PD operation from the bottom
surface is performed.
=> The case for "I The cutting range is a regular parallepiped and
movement extends from a particular bottom surface and enters a side

surface" applies.

P The cutting range is a regular parallepiped and movement extends from a
particular top surface, followed by a three-axis cutting command in which
the Z axis alone extends from the top surface, and thereafter a PU or PD
operation is performed while the X and Y coordinates are inside the
regular parallepiped.
=> Because the Z axis is all the way up, no operation is performed.
Move the X and Y axes directly to a location for entering the top surface.
(These are the coordinates for first executing a tool-up or tool-down
operation with the PU or PD command.)
>From there lower only the Z axis to Z1 and Z2.

Then move the X and Y axes.

Q The cutting range is a regular parallepiped and movement extends from a
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particular top surface, and a PU or PD operation from a side surface is
performed.

=> The case for "G The cutting range is a regular parallepiped and
movement extends from a particular top surface and enters a side surface"

applies.

5-2,Spindle motor
<<About Rotation of the Spindle Motor>>

1. Rotation is performed in the following cases except when expressly
prohibited.

- At the time of a command that involves movement.

The spindle is rotated in the foregoing cases. When movement is involved,
movement is performed after waiting for a certain time to allow rotation to
stabilize.

If the spindle is already rotating, movement is performed immediately

without any wait time.

2. Cases of positive stopping from a rotating state
- At the time of a IMC 0 command

- At the time of an IN command

3. Operations unrelated to rotation

When a command that does not involve movement is received

5-3;Effects of Certain Commands on Other Commands
<<Effects of Certain Commands on Other Commands>>

Coordinate Modes

1 Absolute coordinates
M, D, H: IN, PA, DF After a command at left is executed,
absolute coordinates are in effect.
Thereafter, this does not change until a command effecting relative

coordinates appears.
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@, 'PZ:

Relative coordinates

I, R, PR: After a command at left is executed, relative
coordinates are in effect.

Thereafter, this does not change until a command effecting absolute

coordinates appears.

Affected by relative and absolute coordinates

PU, PD, Z: 1ZZ, 'ZM, 120

A command at left is executed using absolute coordinates if absolute
coordinates are now in effect, and is executed using relative coordinates if
relative coordinates are now in effect.

There is no change from relative to absolute coordinates or vice versa.

Unaffected by relative or absolute coordinates
Execution always uses relative values for parameters, even
when in the absolute-coordinate mode.
I, F: There are no affected parameters.
VvV, W,:
IDW, IMC, INR, IRC, 'VZ

Tool up/down

Tool-up and tool-down operation when PA and PR commands are
combined with other commands

Group 1l H, M, R, D, |, IN, PU, and PD

When a PA or PR command if executed after execution of a group 1
command, tool-up or tool-down operation is performed according to the
result of the group 1 command.

Also, if after executing a group 1 command (step 1), a command other
than a group 1 command is executed (step 2), and a PAor PR command is
then given, the tool-up or tool-down operation is not performed in

accordance with the result of step 2, but with the result of step 1.

Also, the tool default for PA and PR is the raised status.

In the descriptions of the following commands, only the state of the tool before and
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after execution is described.

1 The tool is put into the raised state. If necessary, the raised state is
maintained during movement.
H, M, R, IN, PU

2 The tool is put into the lowered state. If necessary, the lowered state is
maintained during movement.
D, I, PD

3 No change in the tool state before and after execution. Movement is
performed if necessary.
F V,W, Z, DF, IDW, IMC, 122,120, 'ZM




